
QGIS Application - Issues

# Tracker Status Priority Subject Assignee Updated# Tracker Status Priority Subject Assignee Updated

21978 Bug report Closed Normal GDALTools - Processing dialog: Generates file names not enclosed, wrong options, and lacks free option support 2019-05-03 07:59 PM

21978 Bug report Closed Normal GDALTools - Processing dialog: Generates file names not enclosed, wrong options, and lacks free option support 2019-05-03 07:59 PM

20999 Bug report Closed Low Plugin is broken 2019-01-16 02:32 PM

20999 Bug report Closed Low Plugin is broken 2019-01-16 02:32 PM

20988 Bug report Closed Normal Raster operations not working correctly 2019-02-23 05:53 PM

20988 Bug report Closed Normal Raster operations not working correctly 2019-02-23 05:53 PM

20912 Bug report Closed Normal gdalwarp on 3.4.3 behaving differently to 3.4.2 Ross Edwards 2019-01-04 01:32 AM

20912 Bug report Closed Normal gdalwarp on 3.4.3 behaving differently to 3.4.2 Ross Edwards 2019-01-04 01:32 AM

20421 Bug report Closed Normal GeoTIFF gets "Building pyramid overviews is not supported on this type of raster" 2018-11-09 10:12 AM

20421 Bug report Closed Normal GeoTIFF gets "Building pyramid overviews is not supported on this type of raster" 2018-11-09 10:12 AM

20415 Bug report Closed Normal Clip raster by mask layer 2018-12-04 11:33 AM

20415 Bug report Closed Normal Clip raster by mask layer 2018-12-04 11:33 AM

20400 Bug report Closed High crash ID :46bdfc53c9e65ba01bf6e65f60a8fdcad5a2dd77 2019-01-22 01:33 PM

20400 Bug report Closed High crash ID :46bdfc53c9e65ba01bf6e65f60a8fdcad5a2dd77 2019-01-22 01:33 PM

20269 Bug report Rejected Normal gdal tools corrupted 2019-02-05 10:03 PM

20269 Bug report Rejected Normal gdal tools corrupted 2019-02-05 10:03 PM

20268 Bug report Closed Normal gdal tools 2018-10-30 10:36 AM

20268 Bug report Closed Normal gdal tools 2018-10-30 10:36 AM

20103 Bug report Closed Normal Data Type Change in Clip Raster by Mask Layer 2018-10-13 10:34 PM

20103 Bug report Closed Normal Data Type Change in Clip Raster by Mask Layer 2018-10-13 10:34 PM

20069 Bug report Closed Normal Qgis Crashes while perform spatial query (difference) 2019-02-11 05:03 AM

20069 Bug report Closed Normal Qgis Crashes while perform spatial query (difference) 2019-02-11 05:03 AM

20043 Bug report Closed Normal Sieve GDAL error Not recognized as an internal or external command 2019-02-05 10:42 AM

20043 Bug report Closed Normal Sieve GDAL error Not recognized as an internal or external command 2019-02-05 10:42 AM

20004 Bug report Closed Normal Raster Warp(reproject) - reading in file path incorrectly 2018-10-03 01:48 PM

20004 Bug report Closed Normal Raster Warp(reproject) - reading in file path incorrectly 2018-10-03 01:48 PM

19900 Bug report Closed Normal Compute min/max/sum/mean (stats) while Dissolving layer not working (GDAL tool) 2018-09-25 03:13 AM

19900 Bug report Closed Normal Compute min/max/sum/mean (stats) while Dissolving layer not working (GDAL tool) 2018-09-25 03:13 AM

19440 Bug report Closed Normal Corrupt Tif - created by Clip Raster by Extent 2018-08-02 11:08 AM

19440 Bug report Closed Normal Corrupt Tif - created by Clip Raster by Extent 2018-08-02 11:08 AM

19252 Bug report Open Normal GDAL crash in QGIS only when saving a new raster 2018-06-23 02:45 AM

19252 Bug report Open Normal GDAL crash in QGIS only when saving a new raster 2018-06-23 02:45 AM

19241 Bug report Closed Normal error 2018-06-22 05:57 AM

19241 Bug report Closed Normal error 2018-06-22 05:57 AM

19192 Bug report Closed Normal gdalbuildvrt can fails handling wildcards under win10 1803 2018-07-13 02:57 PM

19192 Bug report Closed Normal gdalbuildvrt can fails handling wildcards under win10 1803 2018-07-13 02:57 PM

19171 Bug report Open Normal Translate and Warp raster do not offer ER Mapper *.ers format for output 2018-06-12 02:34 AM

19171 Bug report Open Normal Translate and Warp raster do not offer ER Mapper *.ers format for output 2018-06-12 02:34 AM

19136 Feature request Closed Normal Edit gdal command in the GUI as per previous QGIS version 2018-06-07 02:19 PM

19136 Feature request Closed Normal Edit gdal command in the GUI as per previous QGIS version 2018-06-07 02:19 PM

19029 Bug report Closed Normal GDAL functions ImportError: DLL load failed. The operating system cannot run %1. 2018-11-11 01:20 PM

19029 Bug report Closed Normal GDAL functions ImportError: DLL load failed. The operating system cannot run %1. 2018-11-11 01:20 PM

19003 Bug report Closed High Raster-->Tile index 2018-11-11 04:46 AM

19003 Bug report Closed High Raster-->Tile index 2018-11-11 04:46 AM

18964 Bug report Open Normal Crash While trying to georeference 2018-05-16 07:39 PM

18964 Bug report Open Normal Crash While trying to georeference 2018-05-16 07:39 PM

18945 Feature request Open Normal No data value 2018-05-13 02:58 AM

18945 Feature request Open Normal No data value 2018-05-13 02:58 AM

18374 Feature request Closed Normal Additional warp options 2018-03-08 03:37 PM

18374 Feature request Closed Normal Additional warp options 2018-03-08 03:37 PM

18164 Bug report Closed High Can't get the Clipper Tool to Work 2018-05-16 01:23 PM

18164 Bug report Closed High Can't get the Clipper Tool to Work 2018-05-16 01:23 PM

17997 Bug report Closed Normal QGIS 2.18.16 - gdalwarp - fails to convert XYZ file for no particular reasons 2018-02-23 05:47 PM

17997 Bug report Closed Normal QGIS 2.18.16 - gdalwarp - fails to convert XYZ file for no particular reasons 2018-02-23 05:47 PM

17683 Bug report Closed Normal GDAL Tool translate error when batch mode is selected 2019-02-24 01:10 AM

17683 Bug report Closed Normal GDAL Tool translate error when batch mode is selected 2019-02-24 01:10 AM

17659 Bug report Closed High GDAL 2 problems with : Translate (convert format) 2018-02-23 03:37 PM

17659 Bug report Closed High GDAL 2 problems with : Translate (convert format) 2018-02-23 03:37 PM

17526 Bug report Closed Normal Building virtual raster deforms whole raster in non native projection 2017-11-26 11:21 AM

17526 Bug report Closed Normal Building virtual raster deforms whole raster in non native projection 2017-11-26 11:21 AM

17440 Bug report Closed Normal EPSG 25832 tiffs 2017-11-12 11:02 AM

17440 Bug report Closed Normal EPSG 25832 tiffs 2017-11-12 11:02 AM

16979 Bug report Closed Normal Warp (Reproject) tool not working correctly in QGIS 2.18.11 2017-09-25 04:33 PM

16979 Bug report Closed Normal Warp (Reproject) tool not working correctly in QGIS 2.18.11 2017-09-25 04:33 PM

16632 Bug report Closed Normal GDAL: LZMA codec is missing 2017-05-28 10:50 AM

16632 Bug report Closed Normal GDAL: LZMA codec is missing 2017-05-28 10:50 AM

16620 Bug report Closed Normal gdal tools in raster menu defaulting to output MSGN instead of GTiff 2017-07-06 12:35 AM

16620 Bug report Closed Normal gdal tools in raster menu defaulting to output MSGN instead of GTiff 2017-07-06 12:35 AM

16494 Bug report Closed Normal raster clipper exports XYZ grid file, even when another format is selected 2017-05-04 11:08 AM

16494 Bug report Closed Normal raster clipper exports XYZ grid file, even when another format is selected 2017-05-04 11:08 AM

15549 Bug report Closed Normal GDAL 2.1.1: gdalwarp to VRT produces large output file if cropping to cutline Even Rouault 2016-09-09 12:21 AM

15549 Bug report Closed Normal GDAL 2.1.1: gdalwarp to VRT produces large output file if cropping to cutline Even Rouault 2016-09-09 12:21 AM

15348 Bug report Closed Severe/Regression "extract projection" broken in GDAL tools 2016-07-28 03:06 PM

15348 Bug report Closed Severe/Regression "extract projection" broken in GDAL tools 2016-07-28 03:06 PM

14086 Bug report Rejected Normal gdal tools - proximity (non-ascii characters) 2016-01-13 09:23 AM

14086 Bug report Rejected Normal gdal tools - proximity (non-ascii characters) 2016-01-13 09:23 AM

13967 Bug report Closed Normal gdal_merge crashes python 2015-12-20 04:24 AM

13967 Bug report Closed Normal gdal_merge crashes python 2015-12-20 04:24 AM

13642 Bug report Closed Normal Disabling the GdalTools plugin doesn't clear its tools under Raster menu 2015-12-12 12:02 PM

13642 Bug report Closed Normal Disabling the GdalTools plugin doesn't clear its tools under Raster menu 2015-12-12 12:02 PM

12760 Bug report Closed Normal Qgis 2.8, gdal python scripts gives error at end of process 2015-05-21 12:58 AM

12760 Bug report Closed Normal Qgis 2.8, gdal python scripts gives error at end of process 2015-05-21 12:58 AM

12350 Bug report Closed High GDAL output without proper coordinates 2015-05-10 06:11 AM
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12350 Bug report Closed High GDAL output without proper coordinates 2015-05-10 06:11 AM

11972 Bug report Closed Normal GdalTools clipper: wrong command when mask layer has a filter 2016-01-21 06:29 AM

11972 Bug report Closed Normal GdalTools clipper: wrong command when mask layer has a filter 2016-01-21 06:29 AM

11621 Bug report Closed Normal Raster - Exctraction - Clipper - produce wrong (unequal) cell size 2014-11-12 05:45 AM

11621 Bug report Closed Normal Raster - Exctraction - Clipper - produce wrong (unequal) cell size 2014-11-12 05:45 AM

11507 Bug report Closed Severe/Regression GDAL Tools: error when not choosing an output file format 2014-10-29 03:55 PM

11507 Bug report Closed Severe/Regression GDAL Tools: error when not choosing an output file format 2014-10-29 03:55 PM

11428 Bug report Closed Normal Remove the option "Write absolute path" from gdal tileindex tool 2015-09-30 04:10 PM

11428 Bug report Closed Normal Remove the option "Write absolute path" from gdal tileindex tool 2015-09-30 04:10 PM

11316 Bug report Closed Severe/Regression python error when setting output file name in GDAL tools 2014-10-03 03:10 AM

11316 Bug report Closed Severe/Regression python error when setting output file name in GDAL tools 2014-10-03 03:10 AM

11275 Bug report Closed Severe/Regression Specifying output file in Clipper causes error Luigi Pirelli 2014-10-04 12:51 AM

11275 Bug report Closed Severe/Regression Specifying output file in Clipper causes error Luigi Pirelli 2014-10-04 12:51 AM

11110 Bug report Closed Normal Translate (convert format) [gdal_translate]: export format in batch mode always outputs GeoTIFF 2014-09-11 07:58 AM

11110 Bug report Closed Normal Translate (convert format) [gdal_translate]: export format in batch mode always outputs GeoTIFF 2014-09-11 07:58 AM

10538 Bug report Closed Normal Build Overviews for a Raster 2014-06-10 12:24 PM

10538 Bug report Closed Normal Build Overviews for a Raster 2014-06-10 12:24 PM

9731 Bug report Closed Normal Slope module error 2014-03-06 04:42 PM

9731 Bug report Closed Normal Slope module error 2014-03-06 04:42 PM

9704 Bug report Closed Severe/Regression Gdal Modules Errors on OsX Mavericks William 

Kyngesburye

2014-03-10 11:04 AM

9704 Bug report Closed Severe/Regression Gdal Modules Errors on OsX Mavericks William 

Kyngesburye

2014-03-10 11:04 AM

9477 Feature request Closed Normal GDAL translate: support ESRI rasters folders names as inputs 2014-11-19 07:41 AM

9477 Feature request Closed Normal GDAL translate: support ESRI rasters folders names as inputs 2014-11-19 07:41 AM

9413 Bug report Closed Normal Misalignment after raster clipping 2014-06-23 05:37 AM

9413 Bug report Closed Normal Misalignment after raster clipping 2014-06-23 05:37 AM

9156 Bug report Closed Normal gdal translate creation options are not immediately added to the command 2016-12-30 04:55 AM

9156 Bug report Closed Normal gdal translate creation options are not immediately added to the command 2016-12-30 04:55 AM

9155 Bug report Closed Normal help dialog for gdal translate "creation options" does not seems to show the right way 2014-06-20 11:27 AM

9155 Bug report Closed Normal help dialog for gdal translate "creation options" does not seems to show the right way 2014-06-20 11:27 AM

9023 Feature request Closed Normal QGIS cannot open geopdf under Windows (works on Linux) 2014-11-09 10:28 AM

9023 Feature request Closed Normal QGIS cannot open geopdf under Windows (works on Linux) 2014-11-09 10:28 AM

8916 Bug report Closed Low GDAL Tools: no feedback on extract projection Alexander Bruy 2013-10-19 03:50 AM

8916 Bug report Closed Low GDAL Tools: no feedback on extract projection Alexander Bruy 2013-10-19 03:50 AM

8585 Bug report Closed Normal Converting from Raster to Vector > New CRS 2013-09-07 01:29 PM

8585 Bug report Closed Normal Converting from Raster to Vector > New CRS 2013-09-07 01:29 PM

8519 Bug report Closed Low "layer stack" option in raster->miscellaneous->merge is badly named 2016-05-24 09:47 AM

8519 Bug report Closed Low "layer stack" option in raster->miscellaneous->merge is badly named 2016-05-24 09:47 AM

8467 Bug report Closed Normal (OsX) Raster>Projection>Warp dies after one run 2014-10-14 12:58 AM

8467 Bug report Closed Normal (OsX) Raster>Projection>Warp dies after one run 2014-10-14 12:58 AM

8408 Bug report Closed Normal GdalTools: Output format is already GeoTIFF 2013-09-18 05:29 AM

8408 Bug report Closed Normal GdalTools: Output format is already GeoTIFF 2013-09-18 05:29 AM

8341 Bug report Closed Severe/Regression GDAL clipper returns "ERROR: Did not get any cutline features". with "mask layer" 2013-07-22 09:30 AM

8341 Bug report Closed Severe/Regression GDAL clipper returns "ERROR: Did not get any cutline features". with "mask layer" 2013-07-22 09:30 AM

8323 Bug report Closed Severe/Regression GDAL 1.10 not supported by several tools in Raster menu 2013-07-19 02:11 PM

8323 Bug report Closed Severe/Regression GDAL 1.10 not supported by several tools in Raster menu 2013-07-19 02:11 PM

8165 Bug report Closed Low gdaltools "info" does not work until you change a option 2017-08-08 08:04 AM

8165 Bug report Closed Low gdaltools "info" does not work until you change a option 2017-08-08 08:04 AM

8116 Bug report Closed Severe/Regression GDalTools -  DEM(Terrain Models) tool error 2013-06-22 02:10 AM

8116 Bug report Closed Severe/Regression GDalTools -  DEM(Terrain Models) tool error 2013-06-22 02:10 AM

8115 Bug report Closed Severe/Regression GdalTools - Proximity(raster distance) error 2013-06-22 02:11 AM

8115 Bug report Closed Severe/Regression GdalTools - Proximity(raster distance) error 2013-06-22 02:11 AM

8089 Bug report Closed Severe/Regression Errors with polygonize and rasterize 2013-06-22 02:42 AM

8089 Bug report Closed Severe/Regression Errors with polygonize and rasterize 2013-06-22 02:42 AM

8088 Bug report Closed Normal extract projection fails 2013-06-22 02:44 AM

8088 Bug report Closed Normal extract projection fails 2013-06-22 02:44 AM

8047 Bug report Closed Severe/Regression gdaltool's  input / ouptut file selector broken following SIP upgrade 2013-06-14 03:38 PM

8047 Bug report Closed Severe/Regression gdaltool's  input / ouptut file selector broken following SIP upgrade 2013-06-14 03:38 PM

7832 Bug report Closed Normal QGIS raster, merge 2014-06-21 02:01 PM

7832 Bug report Closed Normal QGIS raster, merge 2014-06-21 02:01 PM

7783 Bug report Closed High Clipper window stays behind project window 2013-05-19 05:45 PM

7783 Bug report Closed High Clipper window stays behind project window 2013-05-19 05:45 PM

7407 Bug report Closed Normal Gdaltools DEM (Terrain model) broken 2013-03-21 03:55 AM

7407 Bug report Closed Normal Gdaltools DEM (Terrain model) broken 2013-03-21 03:55 AM

7366 Bug report Closed Normal GdalTools not loadable 2014-10-06 11:51 AM

7366 Bug report Closed Normal GdalTools not loadable 2014-10-06 11:51 AM

6932 Bug report Closed Severe/Regression gdaltools stopped to work on qgis master 2014-06-29 10:13 AM

6932 Bug report Closed Severe/Regression gdaltools stopped to work on qgis master 2014-06-29 10:13 AM

6887 Bug report Closed Normal GdalTools: support non-ascii path for Windows 2014-06-29 10:13 AM

6887 Bug report Closed Normal GdalTools: support non-ascii path for Windows 2014-06-29 10:13 AM

6695 Bug report Closed Normal Contour extraction doe not consider chosen format 2016-06-21 11:19 AM

6695 Bug report Closed Normal Contour extraction doe not consider chosen format 2016-06-21 11:19 AM

6659 Feature request Rejected Normal gdal_rasterize GUI include the "-tr" option 2012-11-07 08:46 PM

6659 Feature request Rejected Normal gdal_rasterize GUI include the "-tr" option 2012-11-07 08:46 PM

6641 Bug report Closed Normal GDALTools: the option to load a layer after analyses should be on by default Giuseppe 

Sucameli

2012-11-30 12:11 PM

6641 Bug report Closed Normal GDALTools: the option to load a layer after analyses should be on by default Giuseppe 

Sucameli

2012-11-30 12:11 PM

6564 Feature request Closed Normal Function gdal2xyz missing GUI 2012-10-24 02:09 AM

6564 Feature request Closed Normal Function gdal2xyz missing GUI 2012-10-24 02:09 AM

6522 Bug report Closed Normal Pseudo Mercator Projection causes problem while clipping raster data 2013-09-28 01:45 AM

6522 Bug report Closed Normal Pseudo Mercator Projection causes problem while clipping raster data 2013-09-28 01:45 AM

6412 Bug report Closed Normal gdalbuildvrt doesn't recognize chinese directory path 2014-06-29 10:13 AM

6412 Bug report Closed Normal gdalbuildvrt doesn't recognize chinese directory path 2014-06-29 10:13 AM

6301 Bug report Closed Normal Cubic method missing from gdaladdo Giuseppe 

Sucameli

2012-10-02 11:16 PM
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6301 Bug report Closed Normal Cubic method missing from gdaladdo Giuseppe 

Sucameli

2012-10-02 11:16 PM

6280 Bug report Closed Normal error in gdal --> merge 2014-06-29 10:13 AM

6280 Bug report Closed Normal error in gdal --> merge 2014-06-29 10:13 AM

5875 Bug report Closed Normal QGIS doesn't use its own GDAL tools and fails if another version of GDAL is installed 2015-12-30 05:20 AM

5875 Bug report Closed Normal QGIS doesn't use its own GDAL tools and fails if another version of GDAL is installed 2015-12-30 05:20 AM

5746 Feature request Closed Low List layers in alphabetic order Giuseppe 

Sucameli

2012-06-05 08:51 AM

5746 Feature request Closed Low List layers in alphabetic order Giuseppe 

Sucameli

2012-06-05 08:51 AM

5535 Bug report Closed High Merge rasters failure Giuseppe 

Sucameli

2012-05-05 02:10 PM

5535 Bug report Closed High Merge rasters failure Giuseppe 

Sucameli

2012-05-05 02:10 PM

5500 Bug report Closed Normal Dialog windows and Windows network 2016-06-20 03:17 PM

5500 Bug report Closed Normal Dialog windows and Windows network 2016-06-20 03:17 PM

5205 Bug report Closed Normal PCT to RGB not working. 2013-09-22 03:20 AM

5205 Bug report Closed Normal PCT to RGB not working. 2013-09-22 03:20 AM

4931 Bug report Closed Normal Error opening projection selector from  GDALTools warp Giuseppe 

Sucameli

2012-02-01 07:44 AM

4931 Bug report Closed Normal Error opening projection selector from  GDALTools warp Giuseppe 

Sucameli

2012-02-01 07:44 AM

4888 Feature request Closed Normal GDALTools - gdalbuildvrt: Add button for -allow_projection_difference Giuseppe 

Sucameli

2012-02-11 03:51 AM

4888 Feature request Closed Normal GDALTools - gdalbuildvrt: Add button for -allow_projection_difference Giuseppe 

Sucameli

2012-02-11 03:51 AM

4852 Feature request Closed Normal Add gdal2xyz.py to GdalTools 2014-01-27 07:05 AM

4852 Feature request Closed Normal Add gdal2xyz.py to GdalTools 2014-01-27 07:05 AM

4810 Bug report Closed Normal GdalTools: buildVRT results in a file without projection 2015-12-07 07:40 AM

4810 Bug report Closed Normal GdalTools: buildVRT results in a file without projection 2015-12-07 07:40 AM

4740 Bug report Closed Normal Assign projection loads the original raster to canvas 2016-12-28 09:44 AM

4740 Bug report Closed Normal Assign projection loads the original raster to canvas 2016-12-28 09:44 AM

4703 Feature request Closed Low GDAL tools: allow clipping using vector masks in batch mode 2014-06-29 10:13 AM

4703 Feature request Closed Low GDAL tools: allow clipping using vector masks in batch mode 2014-06-29 10:13 AM

4676 Bug report Closed High Python error when interacting with the Clipper raster tool Giuseppe 

Sucameli

2012-01-12 10:04 PM

4676 Bug report Closed High Python error when interacting with the Clipper raster tool Giuseppe 

Sucameli

2012-01-12 10:04 PM

4673 Bug report Closed Normal Rasterizer: let the user choose resolution, not number of rows & columns 2014-07-21 04:12 AM

4673 Bug report Closed Normal Rasterizer: let the user choose resolution, not number of rows & columns 2014-07-21 04:12 AM

4349 Feature request Closed Normal Enable a user to edit the gdaltools commands. 2011-10-05 03:52 AM

4349 Feature request Closed Normal Enable a user to edit the gdaltools commands. 2011-10-05 03:52 AM

4209 Bug report Rejected Normal Fail when using clipper from Gdal Tools 2011-08-23 12:37 AM

4209 Bug report Rejected Normal Fail when using clipper from Gdal Tools 2011-08-23 12:37 AM

4192 Bug report Closed Normal Shapefiles loaded with File browser are not recognized as OGR data sources for rasterization 2013-07-21 11:25 PM

4192 Bug report Closed Normal Shapefiles loaded with File browser are not recognized as OGR data sources for rasterization 2013-07-21 11:25 PM

4191 Bug report Closed Normal Raster clipper does not work with a shp mask Giuseppe 

Sucameli

2011-12-16 03:03 PM

4191 Bug report Closed Normal Raster clipper does not work with a shp mask Giuseppe 

Sucameli

2011-12-16 03:03 PM

4153 Feature request Closed Normal Add fillnodata util Alexander Bruy 2011-11-13 02:30 AM

4153 Feature request Closed Normal Add fillnodata util Alexander Bruy 2011-11-13 02:30 AM

4152 Bug report Closed Normal Move Nearblack close to Sieve Alexander Bruy 2011-08-09 09:32 AM

4152 Bug report Closed Normal Move Nearblack close to Sieve Alexander Bruy 2011-08-09 09:32 AM

4064 Bug report Closed Normal gdal tileindex always write absolute path, regardless what the user chooses in the dialog 2015-09-30 04:10 PM

4064 Bug report Closed Normal gdal tileindex always write absolute path, regardless what the user chooses in the dialog 2015-09-30 04:10 PM

3870 Bug report Closed Low Negative numbers cannot be set as NULL in raster/clipping Giuseppe 

Sucameli

2011-09-16 03:47 AM

3870 Bug report Closed Low Negative numbers cannot be set as NULL in raster/clipping Giuseppe 

Sucameli

2011-09-16 03:47 AM

3869 Bug report Closed Low raster merge: cannot select more than 1 file Giuseppe 

Sucameli

2011-12-23 09:40 AM

3869 Bug report Closed Low raster merge: cannot select more than 1 file Giuseppe 

Sucameli

2011-12-23 09:40 AM

3868 Bug report Closed Low clipping raster: wrong result Giuseppe 

Sucameli

2011-09-01 04:18 AM

3868 Bug report Closed Low clipping raster: wrong result Giuseppe 

Sucameli

2011-09-01 04:18 AM

3836 Bug report Closed Low Qgis crashes rendering ascii layers Giuseppe 

Sucameli

2011-05-31 11:32 PM

3836 Bug report Closed Low Qgis crashes rendering ascii layers Giuseppe 

Sucameli

2011-05-31 11:32 PM

3816 Bug report Closed Low Default color of the terrain Giuseppe 

Sucameli

2011-09-01 02:54 AM

3816 Bug report Closed Low Default color of the terrain Giuseppe 

Sucameli

2011-09-01 02:54 AM

3814 Bug report Rejected Low Polygonize generates a custom projection instead of using the source projection Giuseppe 

Sucameli

2011-09-01 03:18 AM

3814 Bug report Rejected Low Polygonize generates a custom projection instead of using the source projection Giuseppe 

Sucameli

2011-09-01 03:18 AM

3812 Bug report Closed Low Contour does not select a directory Giuseppe 

Sucameli

2011-05-10 02:25 PM

3812 Bug report Closed Low Contour does not select a directory Giuseppe 

Sucameli

2011-05-10 02:25 PM

3729 Bug report Closed Low GdalTools - Virtual Raster Creation: File Path Character Limit Giuseppe 

Sucameli

2011-04-14 02:02 AM
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3729 Bug report Closed Low GdalTools - Virtual Raster Creation: File Path Character Limit Giuseppe 

Sucameli

2011-04-14 02:02 AM

3724 Feature request Closed Low Direct the user to the format-specific documentation for "Creation Options" 2015-11-20 07:17 AM

3724 Feature request Closed Low Direct the user to the format-specific documentation for "Creation Options" 2015-11-20 07:17 AM

3715 Bug report Closed Low GdalTools' pyramids in batch mode remove source files Giuseppe 

Sucameli

2011-04-15 09:55 AM

3715 Bug report Closed Low GdalTools' pyramids in batch mode remove source files Giuseppe 

Sucameli

2011-04-15 09:55 AM

3669 Bug report Closed Low GDAL Tools: rasterize overwrite existing raster without asking for confirmation Giuseppe 

Sucameli

2011-04-14 03:45 AM

3669 Bug report Closed Low GDAL Tools: rasterize overwrite existing raster without asking for confirmation Giuseppe 

Sucameli

2011-04-14 03:45 AM

3668 Bug report Closed Low GDALTools: DEM throws an error Giuseppe 

Sucameli

2011-03-23 07:16 AM

3668 Bug report Closed Low GDALTools: DEM throws an error Giuseppe 

Sucameli

2011-03-23 07:16 AM

3666 Bug report Closed Low GDALTools: translate does not reproject Giuseppe 

Sucameli

2011-03-22 08:59 AM

3666 Bug report Closed Low GDALTools: translate does not reproject Giuseppe 

Sucameli

2011-03-22 08:59 AM

3665 Bug report Closed Low GDALTools: rasterize does not need an existing raster with GDAL >=1.8 Giuseppe 

Sucameli

2011-03-22 09:01 AM

3665 Bug report Closed Low GDALTools: rasterize does not need an existing raster with GDAL >=1.8 Giuseppe 

Sucameli

2011-03-22 09:01 AM

3664 Bug report Closed Low GDALTools: clipper sometimes leaves a red transparent rectangle Giuseppe 

Sucameli

2011-03-22 09:50 AM

3664 Bug report Closed Low GDALTools: clipper sometimes leaves a red transparent rectangle Giuseppe 

Sucameli

2011-03-22 09:50 AM

3663 Bug report Closed Low GDALTools: clipper should act on selected layer only, not all Giuseppe 

Sucameli

2011-04-13 03:17 PM

3663 Bug report Closed Low GDALTools: clipper should act on selected layer only, not all Giuseppe 

Sucameli

2011-04-13 03:17 PM

3662 Bug report Closed Low GDALTools: clipper does not overwrite existing output Giuseppe 

Sucameli

2011-04-13 03:18 PM

3662 Bug report Closed Low GDALTools: clipper does not overwrite existing output Giuseppe 

Sucameli

2011-04-13 03:18 PM

3637 Feature request Closed Low More consistency in name of raster commands Giuseppe 

Sucameli

2011-03-19 12:37 AM

3637 Feature request Closed Low More consistency in name of raster commands Giuseppe 

Sucameli

2011-03-19 12:37 AM

3607 Bug report Closed Low GDALTools: Inconsistent behaviour on windows standalone in QGIS 1.6 2014-06-29 10:13 AM

3607 Bug report Closed Low GDALTools: Inconsistent behaviour on windows standalone in QGIS 1.6 2014-06-29 10:13 AM

3561 Bug report Closed Low qgis crushes when saving edit int table manager Giuseppe 

Sucameli

2011-03-07 04:55 AM

3561 Bug report Closed Low qgis crushes when saving edit int table manager Giuseppe 

Sucameli

2011-03-07 04:55 AM

3545 Feature request Closed Low GDALTools Rasterize should support raster creation with GDAL 1.8 Giuseppe 

Sucameli

2011-03-13 04:22 PM

3545 Feature request Closed Low GDALTools Rasterize should support raster creation with GDAL 1.8 Giuseppe 

Sucameli

2011-03-13 04:22 PM

3476 Bug report Closed Low GDAL raster tools on Windows Vista / 64 require GDAL binary path Giuseppe 

Sucameli

2012-10-02 09:39 AM

3476 Bug report Closed Low GDAL raster tools on Windows Vista / 64 require GDAL binary path Giuseppe 

Sucameli

2012-10-02 09:39 AM

3469 Feature request Closed Low gdaltools: virtual catalog fails with many files 2015-11-19 06:59 AM

3469 Feature request Closed Low gdaltools: virtual catalog fails with many files 2015-11-19 06:59 AM

3435 Bug report Closed Low GDAL - warp fails Giuseppe 

Sucameli

2011-03-13 05:25 AM

3435 Bug report Closed Low GDAL - warp fails Giuseppe 

Sucameli

2011-03-13 05:25 AM

3340 Bug report Closed Low Raster clipper: shifted results Giuseppe 

Sucameli

2011-04-13 03:31 PM

3340 Bug report Closed Low Raster clipper: shifted results Giuseppe 

Sucameli

2011-04-13 03:31 PM

3333 Bug report Closed Low GdalTools: strange responsivenes of multiple files selector 2015-12-22 05:18 AM

3333 Bug report Closed Low GdalTools: strange responsivenes of multiple files selector 2015-12-22 05:18 AM

3170 Bug report Closed Low many GDAL Tools don't work in OS X standalone Giuseppe 

Sucameli

2011-12-09 08:43 AM

3170 Bug report Closed Low many GDAL Tools don't work in OS X standalone Giuseppe 

Sucameli

2011-12-09 08:43 AM

3118 Feature request Closed Low GdalTools (warp): add support for ntv2 grid and +towgs84 transformations Giuseppe 

Sucameli

2011-03-08 11:35 AM

3118 Feature request Closed Low GdalTools (warp): add support for ntv2 grid and +towgs84 transformations Giuseppe 

Sucameli

2011-03-08 11:35 AM

3100 Bug report Closed Low GDAL tools crash QGIS when a layer is removed from the canvas Giuseppe 

Sucameli

2011-03-14 09:02 AM

3100 Bug report Closed Low GDAL tools crash QGIS when a layer is removed from the canvas Giuseppe 

Sucameli

2011-03-14 09:02 AM

3066 Feature request Closed Low GdalTools: clipping based on a shapefile mask Giuseppe 

Sucameli

2011-04-15 10:58 AM

3066 Feature request Closed Low GdalTools: clipping based on a shapefile mask Giuseppe 

Sucameli

2011-04-15 10:58 AM

3064 Feature request Closed Low GdalTools: add gdaldem and other new GDAL tools Giuseppe 

Sucameli

2011-09-01 02:46 AM
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3064 Feature request Closed Low GdalTools: add gdaldem and other new GDAL tools Giuseppe 

Sucameli

2011-09-01 02:46 AM

3048 Bug report Closed Low Seg-fault on Debian Squeeze invoking any of GdalTools Giuseppe 

Sucameli

2011-04-09 02:09 AM

3048 Bug report Closed Low Seg-fault on Debian Squeeze invoking any of GdalTools Giuseppe 

Sucameli

2011-04-09 02:09 AM

3041 Feature request Closed Low Make the GdalTools command window editable Giuseppe 

Sucameli

2011-10-06 04:44 PM

3041 Feature request Closed Low Make the GdalTools command window editable Giuseppe 

Sucameli

2011-10-06 04:44 PM

2941 Feature request Closed Low GDALTools - Grid: allow for more control of the output Giuseppe 

Sucameli

2011-03-14 01:51 AM

2941 Feature request Closed Low GDALTools - Grid: allow for more control of the output Giuseppe 

Sucameli

2011-03-14 01:51 AM

2914 Feature request Closed Low gdal tools: allow (in user interface) to choose for +towgs84 or +nadgrids parameters Giuseppe 

Sucameli

2011-03-08 11:30 AM

2914 Feature request Closed Low gdal tools: allow (in user interface) to choose for +towgs84 or +nadgrids parameters Giuseppe 

Sucameli

2011-03-08 11:30 AM

2808 Feature request Closed Low access wktraster using gdaltools Giuseppe 

Sucameli

2011-12-23 01:12 PM

2808 Feature request Closed Low access wktraster using gdaltools Giuseppe 

Sucameli

2011-12-23 01:12 PM

1199 Feature request Closed Low let the user specify overviews format and compression 2014-06-29 10:12 AM

1199 Feature request Closed Low let the user specify overviews format and compression 2014-06-29 10:12 AM
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